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Changes from Version 4.1 t0 5.0
There have been several changes from Version 4.1 to 5.0. Most are source-code compatible meaning you
won’t have to change your source code. One change may require you to change your source code.

There is now support for a Command-based robot project. This is a new methodology for writing
robot programs that should make writing large programs much easier and more scalable. See the
WPILib Cookbook located in the Documents area on the WPILib FIRSTForge project at
http://firstforge.wpi.edu.

There is substantially improved support for the SmartDashboard that is extremely useful for
debugging robot programs or monitoring their operation while the robot is operating.

There is a set of methods to allow you to easily exchange data with programs running on the
driver station computer. This is particularly useful if you decide to do some robot processing on
the laptop such as Kinect or vision processing.

The AxisCamera class now defaults to using the IP address of 10.x.y.11 where X.y represents your
team number in the same format as all the other devices on the robot subnet. You can pass a
different IP address to the AxisCamera::GetInstance() method as a string.

Other bug fixes and improvements throughout the library.



What is the WPI Robotics Library

The WPI Robotics library is a set of classes that interface to the hardware in the FRC control system and
your robot. There are classes to handle sensors, motors, the driver station, and other utility functions like
timing and field management.

We believe that the object oriented programming paradigm best fits robot programming with WPILib,

hence the use of C++ in this Guide, but C programming is also available. Here’s an example of using C with
the WPI Robotics Library.

The following C program demonstrates driving the robot forward for 2 seconds during the Autonomous
period of the game and driving with arcade-style joystick steering during the Operator Control (or
“teleop”) period. (Notice that constants define the I/O port numbers used in the program. This is a good
practice and should be used for C and C++ programs.)

#include “WPILib.h”
#include “SimpleCRobot.h”

static const UINT32 LEFT MOTOR PORT = 1;
static const UINT32 RIGHT MOTOR PORT = 2;
static const UINT32 JOYSTICK PORT = 1;

void Initialize (void)

{
CreateRObOtDrive(LEFT_MOTOR_PORT, RIGHT_MOTOR_PORT);
SetWatchdogExpiration (0.1) ;

}

void Autonomous (void)
{
SetWatchdogEnabled (false) ;
Drive (0.5, 0.0);
Wait (2.0) ;
Drive (0.0, 0.0);
}

void OperatorControl (void)

{
SetWatchdogEnabled (true) ;
while (IsOperatorControl ())

{
WatchdogFeed () ;
ArcadeDrive(JOYSTICK_PORT);

}

START ROBOT CLASS (SimpleCRobot) ;

Example 1: A simple C program to drive in autonomous and operator control modes.

The WPI library is designed to:

* Deal with all the low level interfacing to these components so you can concentrate on solving this
year’s “robot problem.” This is a philosophical decision to let you focus on the higher-level design
of your robot rather than deal with the details of the processor and the operating system.

* Letyou understand it at all levels by making the full source code of the library available. E.g. you
can study (and modify) the algorithms used by the gyro class for oversampling and integrating the
input signal or just call it to get the current robot heading. You can work at any level.



Using Wind River Workbench and C/C++

The development tool suite to create C++ robot programs is called Workbench from Wind River. Wind
River Workbench is a complete, professional C/C++ Interactive Development Environment (IDE) that
handles all aspects of code development. It will help you:

*  Write the code for your robot with editors, syntax highlighting, formatting, auto-completion, etc.
* Compile the source code into binary object code for the cRIO PowerPC architecture.

* Debug and test code by downloading the code to the cRIO robot controller and enabling you to
step through line by line and examine variables of the running code.

* Deploy the program to the robot’s flash memory so it will automatically start up when the robot is
powered on.

* You can even use Subversion, a popular source code revision control system to manage your code
and track changes. This is even more useful if your team has more than one programmer.

Setting up the environment
To use Workbench you need to configure it so that it knows about your robot and the programs that you
want to download to it. There are three areas to set up.

1. The target remote system, which is the robot cRIO that you will download your program to for
testing and debugging.

2. The run or debug configuration that describes the program to debug and which remote system
you want to debug it on.

3. The FIRST Downloader settings that tell which program to deploy to the cRIO when you're ready
to download it for a competition or operation without the laptop.

Creating a Remote System in Workbench

Workbench connects to your cRIO controller and can download and remotely debug programs that are
running on it. In order to make that connection, Workbench needs to add your cRIO to its list of Remote
Systems. Each entry in the list tells Workbench the network address of a cRIO and the location of a kernel
file that is required for remote access. To create the entry for your system, perform the following steps.

Note:  To ensure the “Reset connected Target” command (this reboots the Target server, i.e. the Wind River
OS on the cRIO) and other features work reliably, set the “Console out” switch on the cRIO to “on.”
This enables console text output via a serial cable to a laptop, which is very handy for debugging
problems like when the robot program fails to start up. Leaving this switch on improves system
reliability even when there's no serial cable connected. On the other hand, when you're using the serial
port to control a Black Jaguar motor speed controller, you'll need to set the Console out switch to

“off.”

Right-click in the empty area in the “Remote Systems” window and select “New Connection.”
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In the “Select Remote System Type” window choose “Wind River VxWorks 6.x Target Server Connection”
and click “Next.”

Fill out the “Target Server Options” window with the IP address of your cRIO. It is usually 10.x.y.2 where x
is the first 2 digits of your 4 digit team number and y is the last two digits. For example, team 190 (0190)
is 10.1.90.2.

You must also select a Kernel Image file. This is located in the WindRiver install directory in the WPILib
directory. There are Kernel Image files, one for the 4-slot cRIO and one for the 8-slot cRIO. Be sure to use
the Kernel image that matches your hardware:

8-slot (2011 and previous) | cRIOFRC_vxWorks

4-slot (2012 and later) cRIOFRCII_vxWorks

Finally, click the “Select” button near the top right corner of the window. Click the “+” next to “MPC5xxx”
to expand the choices. Select “MPC52xx” the click OK. Click “Finish” to create the connection.
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Note:  be sure to use one of the two VxWorks kernel image files as described in the previous section.

If the cRIO is turned on and connected the target server entry will now list the cRIO’s running tasks.
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Creating a robot project
The easiest way to create your own project for your robot is to start with one of the existing templates:

* SimpleRobotTemplate
¢ TIterativeRobotTemplate
¢ CommandBasedRobotTemplate

Both of these templates build on the rRobotBase class and override some functions to change the behavior.
More project templates are available.

Follow these steps to create a robot project. Here we’ll use the simpleRobotTemplate but you can start
from any of the provided samples.

Click the main command File > New > Example... In the New Example wizard select “VxWorks
Downloadable Kernel Module Sample Project” and then click “Next.”
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Select a wizard —p
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Select “FRC Simple Robot Template” from the Sample Project Template window. Notice the description of
the template in the Information panel. Click “Finish” and Workbench will create a project in your
workspace that you can edit into your own program.
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Building your project

Build the project by right-clicking on the project name in the Project Explorer window and selecting
“Build project” or “Rebuild project” from the popup context menu. This will make Workbench compile
and link the project files into a .OUT executable file that may be deployed to or downloaded to the cRIO.

Note:  Sometimes after creating a new Workbench project, building it the first time doesn’t actually build
anything. You won’t notice very much activity in the “Build Console” tab. If this happens, simply exit
and restart Workbench and rebuild. This seems to only happen the first time a new project is built.

Another way of building the project is to use Workbench'’s “automatic rebuild” feature. It will rebuild the
project automatically whenever you save a source file. To enable this feature:

1. Select Window > Preferences.

2. In the Preferences panel, expand “General,” then click “Workspace,” and check the “Build
automatically” option. Quickly save an edited file via the Ctrl-S keyboard shortcut, or save all open
files at once using the Save All shortcut, Ctrl-Shift-S.

Tip: Also turn on “Save automatically before build.”” Then Workbench will save your changes to all files
before building. Otherwise it can build with only some of your edits, which doesn't work very well.
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Downloading the project to the cRIO

Before you can download your program to the robot the cRIO needs to have the correct version of the
image. Several tools are required:

Besides the tools for C++ programming you'll also need:

* The FRC cRIO Imaging Tool to format/initialize your cRIO for Java programming. Be sure to use
the 2012 FRC cRIO Imaging tool for updating the image on your cRIO. Previous versions will not
work with the 2012 image file format and the libraries will not work with older images.

* Usethe 2012 FRC Driver Station software to control your robot.

All of these tools are available from National Instruments (NI.com).

Labview update http://joule.ni.com/nidu/cds/view/p/id/2261
Utilities update http://joule.ni.com/nidu/cds/view/p/id /2262
Driver station update http://joule.ni.com/nidu/cds/view/p/id/2263

There are two ways of getting your project into the cRIO:

* Using a Run/Debug Configuration in Workbench. This loads the program into the cRIO RAM
memory and allows it to run, with or without the debugger. When the robot is rebooted, the
program will no longer be in memory.

* Deploy the program through the FIRST Downloader option in Workbench. This writes the
program to flash memory in the cRIO where it will run whenever the cRIO reboots (that is, until
you Undeploy it). This is how to make your program available for a match so it will run without an
attached computer.

Caution: Be sure to not use the Run/Debug configuration if you have a robot program deployed and thus
starting up automatically in the background. Having two robot programs trying to run at the same
time is very confusing. Use the Undeploy menu item if you think there is already a deployed program.

It sometimes helps to reboot between debugging sessions. Sometimes things don’t get completely
cleaned up even if you try to unload the program. We're working on that.

You can reboot the cRIO from your development computer by right-clicking on the connection in the
“Remote Systems” tab in Workbench and selecting “Reset connected Target.” Or reboot the cRIO via the
Driver Station’s Reboot option. It takes about 15 seconds to reboot.



Debugging your robot program

You can monitor, control, and manipulate cRIO processes using the debugger. This section will describe
how to set up a debug session for a robot control program. (See the Wind River Workbench User’s Guide
for complete documentation on how to use the debugger: Help > Help Contents > Wind River
Documentation > Guides > Host Tools > Wind River Workbench User’s Guide.)

To run a program that derives from one of the WPILib robot base classes such as SimpleRobot.cpp or
IterativeRobot.cpp, your program should call the macro sTaART ROBOT cLass. (See SimpleDemo Or
IterativeDemo for examples.) That starts an initial task that then starts the robot task with the correct
run options. This makes it necessary to set up the debug options to attach to the spawned robot task
instead of the initial task.

To start a debug session, first ensure the PC is connected to the target. Then right-click on the project
name in the “Project Explorer” window and select “Debug Kernel Task...” to open the Debug dialog:
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Figure 1: Setting the entry point on a Debug Configuration for a robot program.

Change the name of the debug target to something meaningful like “2010TargetTest” in the figure, or
maybe “2011HighScoringRobot.” Select as the entry point the function
FRC_UserProgram_ StartupLibraryInit.



In the Debug Options tab, select “Break on Entry” and “Automatically attach spawned Kernel Tasks.” This
tells the debugger to stop at the program’s first instruction and make the spawned task (your robot task)
available to debug.
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Figure 2: Setting the “Automatically attach spawned Kernel Tasks” option ensures that you will be able to debug the entire program
including the robot's main task and any tasks that it creates.

The other options can normally be left at default settings. Apply your changes.

Clicking the “Debug” button does several things. It changes the Workbench to the Debug Perspective
which has the views Debug, Breakpoints, and Variables along the right side of the window. It starts the
robot task and pauses it at the first program statement, in FRC_UserProgram StartupLibraryInit. Now
double-click in the left margin of the source code window to set a breakpoint in your user program:

{

void OperatorControl (void)

HSLImage testImage;

AxisCamera &camera = AxisCamera::getInstance():
camera.writeResolution (k160x120);
camera.writeBrightness (0);

Wait (3.0);

A small blue circle indicates the breakpoint has been set on the corresponding line. (You can see all your
breakpoints in the Workbench'’s Breakpoints view.)



Click the “Resume” button (the green arrow) to resume program execution up to the first breakpoint.
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The Debug view shows all processes and threads running in the cRIO. Select the stack frame to see the
current instruction pointer and source code (if available) for the selected process. When your breakpoint
is reached, make sure your program is selected in the task list and your source code is displayed with a
program pointer. You can continue stepping through your code using “Resume,” “Step Into,” “Step Over,”
and “Step Return” buttons:
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If you see assembly code instead of C++ code displayed, it's because you've stepped down into library
code where the source is not available to the debugger. “Step Return” will bring you back up a level.

The Variables view shows the current values of variables. To see a variable that is not displayed, select
the “Expressions” tab and enter the variable name. This will show the variable’s value if it’s in scope.
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To stop debugging, you can disconnect or terminate the process. Disconnecting detaches the debugger
but leaves the process running in its current state. Terminating the process Kkills it on the target.

Troubleshooting:

Source code displayed is out of sync with cursor when debugging: The source has changed since it
was loaded onto the cRIO. Rebuild the project (build clean) and make sure included projects are up to
date.

Robot program not visible in the Debug View: Make sure that the “Automatically attach spawned
Kernel Tasks” option is on. When you click “Debug,” the cRIO will first pause in initialization code, before
it gets to your program. When you “Resume” it will soon begin your robot program.

Getting printf or cout output on the PC
Printing some text from your program is a handy way to debug and tune it. There are four ways to see
printf or cout output, each with advantages and disadvantages:

Connect a serial cable between the computer and robot  Starts working early in ~ Robot must be tethered.

controller bootup Takes up the serial port.
Use a network Target Console. To do that, right-click Doesn’t need the serial ~ You have to do it again after
on the remote system, then “Target Tools,” then port or a serial cable each reboot. Doesn’t start
“Target Console”. This creates a console window that working early in bootup.

gets the text over the network.

Allocate a console. In the Run menu, select Open Run Survives reboots Only shows the current
Dialog... or Open Debug Dialog... Select your Kernel task’s output

Task FRC_UserProgram_StartupLibrarylnit in the left

pane. Then find the “Common” tab and check the

“Allocate Console” checkbox.

NetConsole over Ethernet Captures all stdout, Requires NetConsole to be
stderr, and VxWorks running on the cRIO

commands

The NetConsole is now the preferred way to get output back from the cRIO. It has the advantage of
starting up early on as the cRIO boots so all the informational messages are forwarded to the user and
shows output from all tasks running. The use of Netconsole can be enabled by using the Imaging Tool and
checking the NetConsole checkbox when reimaging the controller to enable NetConsole output.



NetConsole is automatically installed with the NI utilities at the same time as the Imaging tool and other
utilities. You can start it by finding it in the start menu under LabVIEW.

Note:  Netconsole will only work if the netmask on the interface connected to the robot is set to 255.0.0.0.
Everything else will work with a netmask of 255.255.255.0, but NetConsole will not connect.



Deploying the C/C++ Program

Deploying a program to the cRIO copies it to a file in flash memory that will automatically start when the
robot turns on. The FIRST Downloader plug-in for Workbench has commands to Deploy (i.e. download)
the program to the cRIO and Undeploy (i.e. delete) the program from the cRIO.

Caution:Don’t try to debug a robot program as described above while there is a deployed robot program that
automatically runs when the cRIO boots. Having both robot programs try to start up is unhelpful.

)

Before deploying a program for the first time, you need to configure the “FIRST Downloader Preferences.’
This is done via Window > Preferences... > FIRST Downloader Preferences.
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Fill in your team number and the .OUT file for your project that should be loaded. The .OUT file will
typically be in the PPC603gnu directory in the Workbench workspace directory for your project. This
step is easy to do after you built it.

Once this is set up, deploy the project using the menu command FIRST > Download. The default
workspace location is c:\WindRiver\Workspace. It will copy the .OUT file to the correct directory and
filename on the cRIO. Now when the cRIO restarts, it will automatically run this program.

To undeploy the program, use the menu command FIRST > Undeploy.



Creating a Robot Program
Now consider a very simple robot program that has these characteristics:

Autonomous period Drives in a square pattern by driving at half speed for 2
seconds to make each side then turn 90 degrees. Repeat 4

times.

Operator Control Uses two joysticks to provide tank steering for the robot.
period

Robot specifications:

Left drive motor PWM port 1
Right drive motor PWM port 2
Joystick Driver station joystick ports 1 and 2

Starting with the simple template for a robot program we have:

#include “WPILib.h”
class RobotDemo : public SimpleRobot

{

public:
RobotDemo ()
{

// put initialization code here

}

void Autonomous ()

{

// put autonomous code here

}

void OperatorControl ()

{

// put operator control code here

}
}i

START ROBOT CLASS (RobotDemo) ;

Example 2: Starting point for robot program

Now define a robot drive object for motors in ports 1 and 2 and joystick objects for joystick ports 1 and 2:

class RobotDemo : public SimpleRobot
{
RobotDrive drive (1, 2);
Joystick leftStick(1l);
Joystick rightStick(2);

Example 3: C++ Example 2: Adding robot drive and joystick objects to the program
To simplify this example, we’ll disable the watchdog timer. (The watchdog is a safety feature in the WPI

Robotics Library that helps keep your robot from running away, out of control if the program
malfunctions. You don’t really want to disable it. If necessary, give it a longish timeout.)




RobotDemo ()

{
GetWatchdog () .SetEnabled (false) ;

}

Example 4: Disabling the watchdog timer for this simplified example

Now write the autonomous part of the program to drive in a square:

void Autonomous ()

{
for (int i = 0; 1 < 4; i++)
{

drive.Drive (0.5, 0.0); // drive 50% forward speed with 0% turn

Wait (2.0); // walit 2 seconds
drive.Drive (0.0, 0.75); // drive 0% forward speed with 75% turn
Wait (0.75) // Wait for the robot to turn 90 degrees
}
drive.Drive (0.0, 0.0); // drive 0% forward speed with 0% turn (stop)

Example 5: Autonomous program that drives in a square

Now write the operator control part of the program:

void OperatorControl ()

{
while (IsEnabled() && IsOperatorControl ()) // loop forever

{
drive.TankDrive (leftStick, rightStick); // drive with the joysticks
Wait (0.005) ;

Example 6: Simple tank drive with two joysticks

This applies joystick control values to the drive motors, every 5 milliseconds.



Putting it all together we get this very short program that accomplishes some autonomous task and
provides operator control tank steering:

#include “WPILib.h”

class RobotDemo : public SimpleRobot

{
RobotDrive drivetrain(l, 2);
Joystick leftStick(1l);
Joystick rightStick(2);

public:
RobotDemo ()
{
GetWatchdog () .SetEnabled (false) ;

}

void Autonomous ()

{
for (int i = 0; 1 < 4; i++)
{

drive.Drive (0.5, 0.0); // drive 50% forward speed with 0% turn

Wait (2.0); // walit 2 seconds
drive.Drive (0.0, 0.75); // drive 0% forward speed with 75% turn
Wait (0.75) ; // turn for 3/4 second
}
drive.Drive (0.0, 0.0); // drive 0% forward speed with 0% turn (stop)

}

void OperatorControl ()

{
while (1) // loop forever

{
drive.Tank (leftStick, rightStick); // drive with the joysticks

Wait (0.005) ;

}i

START ROBOT CLASS (RobotDemo) ;

Example 7: Completed example program. Notice the 0.75 second Wait that is a amount computed for the sample robot to
complete a 90 degree turn.

Some details:

* Inthis example drive, leftStick, and rightStick are member objects of the RobotDemo class.
They’re accessed using references, one of the ways of accessing objects in C++. The next section
will introduce pointers as an alternate technique.

* Thedrive.Drive () method takes two parameters: a speed and a turn rate. See the documentation
about the robotDrive object for details on how the speed and direction parameters work.

* Disabling the Watchdog safety timer is a bad idea! You should enable the watchdog timer, set its
feeding interval, and “Feed” it at least that often.



Using objects

The WPI Robotics Library accesses all sensors, motors, driver station elements, and more through
objects. Most objects correspond to the physical things on your robot like sensors. Objects have the code
and the data needed to operate that physical thing. Let’s look at a gyro. The operations (or methods) you
can perform on a gyro are:

* Create the gyro object - this sets up gyro communications and calibrates the gyro
* Configure the gyro parameters, i.e. its sensitivity

* Getthe current heading, or angle, from the gyro

* Reset the current heading to zero

* Delete the gyro object when you're done using it

Creating a gyro object is done like this:

Gyro robotHeadingGyro (1) ;

The variable robotHeadingGyro holds a Gyro object that operates a gyro module connected to analog port
1. That’s all you have to do to make an instance of a Gyro object.

Note:  An instance of an object has a block of memory for that instance's data. When you create an object,
that memory block gets allocated and when you delete the object that memory block gets deallocated.

To get the current heading from the gyro, you simply call the cetangle method of the gyro object. Calling
this method is really just calling a function that works on the data specific to this gyro instance.

float heading = robotHeadingGyro.GetAngle () ;

This sets the variable heading to the current heading from the gyro on analog channel 1.

Creating object instances
There are several ways of creating object instances in C++. These ways differ in how the object should be
referenced and deleted. Here are the rules:

Location Create object Use the object When the object is deleted
Variable declared Victor leftMotor(3); 1leftMotor.Set(1.0); Object is automatically deleted
inside an object, when the enclosing block exits or
function, or block the enclosing object is deleted
Global declared Victor leftMotor(3); leftMotor.Set(1.0); Object is not deleted until the
outside of any program exits

enclosing objects or
functions; or a static

variable

Pointer to object Victor *leftMotor = leftMotor->Set(1.0);  Object must be explicitly deleted
new Victor(3); using the C++ delete operator.

How do you decide what to use? The next section will discuss this.




Pointers and addresses

There are two ways of declaring an object variable: either as an instance of the object or a pointer to an
instance of the object. In the former case the variable holds the object and the object is created
(“instantiated”) at the same time. In the latter case the variable only has space to hold the address of the
object. It takes another step to create the object instance using the new operator and assign its address to
the variable. Look at these two code snippets to see the difference:

Joystick stickl (1) // this is an instance of a Joystick object stickl

stickl.GetX () ; // access the instance using the dot (.) operator

bot->ArcadeDrive (stickl) ; // you can pass the instance to a method by reference
// .. ArcadeDrive (Joystick& 7J)

Joystick *stick2; // a pointer to an uncreated Joystick object

stick2 = new Joystick(1l); // creates the instance of the Joystick object

stick2->GetX () ; // access the instance with the arrow (->) operator

bot->ArcadeDrive (stick?2) ; // you can pass the instance by pointer (notice, no &)
// .. ArcadeDrive (Joystick* )

delete stick2; // delete the object when you’re done with it

ArcadeDrive () in WPILib takes advantage of a C++ feature called function overloading. This allows it to
have two methods with the same name that differ by argument lists. The one Arcadebdrive (Joystick &3)
takes the parameter j as a reference to a Joystick instance. You supply a Joystick and the compiler
automatically passes a reference to that instance. The other Arcadebrive (Joystick *7j) takes the
parameter j as a pointer to a Joystick instance. You supply a pointer to a Joystick instance. The cool
thing is that the compiler figures out which arcadeprive to call. The library is built this way to support
both the pointer style and the reference style.

If you had non-overloaded functions ref (Joystick &j) and Ptr (Joystick *3),you could still call them
if you use the right C++ operators: Ref (*stick2) and Ptr (sstickl). At run time, references and pointers
are both passed as addresses to the instance. The difference is the source code syntax and details like
allocation and deletion.

WPI Robotics Library Conventions
This section documents some conventions used throughout the library to standardize its use and make
things more understandable. Knowing these should make your programming job much easier.

Class, method, and variable naming
Names follow these conventions:

Type of name Naming rules Examples

Class name Initial upper case letter then camel Victor, SimpleRobot, PWM
case (mixed upper/lower case) except

acronyms which are all upper case

Method name Initial upper case letter then camel StartCompetition Autonomous, GetAngle
case

Member “m_" followed by the member variable m_deleteSpeedControllers,

variable name starting with a lower case letter =~ m_sensitivity

then camel case




Local variable Initial lower case targetAngle
Macro All upper case with _ between words. DISALLOW_COPY_AND_ASSIGN

Note: It’s better to use const values

and inline functions than macros.

Constructors with slots and channels

In past releases you might have had slot numbers in your code. To make programs compatible between
the 4-slot and 8-slot cRIO we have moved to a module numbering scheme. Rather than using the actual
slot number a module is loaded in, the number is the instance of the module type. For example the first
digital module would be 1 and the second one would be 2. If you only had a single module of each type in
your robot and you used the short form of the constructors when creating devices (where the slot
number argument was left out and defaulted to the first module) then your code doesn’t have to change.
The library will continue to default the numbers to the first module of a given type. If you explicitly
passed the slot number to the constructors, then it will likely have to change. The module(s) in slot 4 of
the 4-slot cRIO-FRC II or slots 5-7 of the 8-slot cRIO FRC will be referred to as Module 2.

For example:
Jaguar wristMotor = new Jaguar(2); // first digital module, pwm port 2
Since the slot number was implicit this won’t have to change. But if you did this:
Jaguar wristMotor = new Jaguar(4, 2); // digital module slot 4, pwm 2
Then this will have to change to: new Jaguar(1, 2); // 1st digital module

Module Ordering

All teams will now be working with the new cRIO images which require the new module order. There is a
new module order for 2012 to create some symmetry between the 8-slot and 4-slot cRIOs. The new
module order is as follows:

Physical | Module 8-slot cRIO 4-slot cRIO
Slot number
number | inyour
program

1 Analog Module 9201 Analog Module 9201

1 Digital Module 9403 Digital Module 9403

3 1 Solenoid Module 9472 | Solenoid Module
9472

4 2 empty Any module type

5 2 Analog Module 9201 NA

6 2 Digital Module 9403 NA

7 2 Solenoid Module 9472 | NA

8 empty NA

Examples are:



Jaguar (UINT32 channel) // channel with default module (2)

Jaguar (UINT32 module, UINT32 channel) // channel and module
Gyro (UINT32 module, UINT32 channel) // channel with explicit module
Gyro (UINT32 channel) // channel with default module (1)

Example 8: Sharing inputs between objects

WPILib object constructors generally use the port number(s) to select and reserve cRIO input and output
channels. E.g. when you instantiate an encoder object, it reserves that digital input channel.

Built-in Robot classes

There are several built-in robot base classes to help you quickly create a robot program. Subclass the one
that best fits your requirements and preferences.

Table 1: Built-in robot base classes to create your own robot program.

Class name Description

SimpleRobot This template is the easiest to use and is designed for writing a straight-line
autonomous routine without complex state machines.

Pros:

* There are only three places to put your code: the constructor for
initialization, the Autonomous method for autonomous code and the
OperatorControl method for teleop code.

* Sequential robot programs are trivial to write. Just code each step one
after another.

* No state machine is required for multi-step operations. The program
can simply do each step sequentially.
Cons:
* Switching between autonomous and operator control code may require
rebooting the controller if your program gets stuck in a loop.
* The autonomous method will keep running until it decides to exit, so it
could continue to run during the operator control period. You don’t

want that. So be sure to make your loops check if the field state is still in
the autonomous period.




IterativeRobot This template gives additional flexibility in the code for responding to various
field state changes (autonomous, operator control, disabled) in exchange for
additional complexity in your program. rterativeRobot repeatedly calls one of
your methods depending on the current field state. The intent is that each
method will do some processing for that field state and then return. That way,
as soon as the field state changes, 1terativeRobot starts calling a different
method.

Pros:

* You get fine-grain control of field state changes, especially if you're
practicing and retesting the same field state over and over.

Cons:

* [It's more difficult to write action sequences that unfold over time, e.g. an
autonomous sequence. That requires state variables to remember what
the robot was doing from one call to the next.

Command-based Although not a robot class, the Command-based robot programs are a major
Robot addition to WPILib for 2012. There are a number of new classes and
integration with the SmartDashboard. Please refer to the Robot Programming
Cookbook on the WPILib Project at FIRSTForge.wpi.edu. It includes detailed
instructions on using these new features and is worth looking at.

RobotBase The base class for the above classes. This provides all the basic functions for
field control, the user watchdog timer, and robot status. Extend this class to if
you need more flexibility.

SimpleRobot class

The simpleRobot class is designed to be the base class for a robot program with straightforward
transitions from Autonomous to Operator Control periods. There are three methods to fill in to complete
ad SimpleRobot program.

Table 2: SimpleRobot class methods that are called as the field state progresses through the match

Method What it does

the Constructor Put code in the constructor to initialize the sensors, motors, pneumatics,
(method with the same and your robot program variables. This code runs as soon as the robot is
name as the robot turned on, before it’s enabled, that is, before it can operate motors and
class) other actuators. When the constructor exits, the program will wait until

the robot is enabled.

Autonomous() Put code in the Autonomous method to run the robot during the
autonomous period of the match. When this method exits, the program
will wait until the start of the operator control period. This method had
better detect the end of the autonomous period since it won’t be
interrupted when it’s time for operator control. If this method has an
infinite loop, it won’t stop until the entire match ends.

OperatorControl() Put code in the operatorcontrol method to run the robot during the
operator control part of the match. This method will be called after the
Autonomous method has exited and the field has switched to the operator
control part of the match. If your program exits from the operatorControl
method, it will not resume until the robot is reset.



IterativeRobot class

The 1terativeRobot class organizes your robot program (your subclass) into methods that it calls
according to the match state. For example, it calls your AutonomousContinuous method repeatedly during
the autonomous period. When the playing field (or the Driver Station setting) changes to operator
control, it calls the Teleopinit method then starts calling the Teleopcontinuous method repeatedly.

WindRiver Workbench has a sample robot program based on the T1terativeRrobot base class. If you want
to use it, follow the instructions from the previous section except select “Iterative Robot Main Program.”
This will create the project and a skeletal robot program in your workspace.

When basing a robot program on the 1terativeRobot base class, you implement these methods:

Table 3: IterativeRobot calls these methods of your robot program as the match proceeds:

Method name Description

RobotInit Called when the robot is first turned on. You put initialization code here or in
the constructor. This method is only called once.

DisabledInit Called once each time the robot becomes disabled.

Autonomouslnit Called once when the match enters the autonomous period from any other
state.

Teleoplnit Called once when the match enters the teleoperated period from any other
state.

DisabledPeriodic Called periodically during the disabled part of the match, using a periodic timer.

AutonomousPeriodic Called periodically during the autonomous part of the match, using a periodic
timer.

TeleopPeriodic Called periodically during the teleoperated part of the match, using a periodic
timer.

DisabledContinuous Called continually during the disabled part of the match. When this method

returns, it gets called again if the match state hasn’t changed.

AutonomousContinuous Called continually during the autonomous part of the match. When this method
returns, it gets called again if the match state hasn’t changed.

TeleopContinuous Called continually during the teleoperated part of the match. When this method
returns, it gets called again if the match state hasn’t changed.

The three Init methods are called on transition into the relevant field state. The Continuous methods are
called repeatedly while in that state, after calling the appropriate Init method. The Periodic methods are
called periodically while in a given state. Call the 1terativeRobot class’s setPeriod method to set the
period interval. The periodic methods are intended for time-based algorithms like PID control. During
each match state, its periodic and continuous methods will both be called, at different rates.

RobotBase class

The robotBase class is the superclass of the simpleRobot and IterativeRobot classes. If you decide not
to build on simpleRobot Or IterativeRobot, then subclass RobotBase directly. RobotBase has all the
methods to determine the field state, set up the watchdog timer, handle communications, and do other
housekeeping work.



Create a subclass of RobotBase and implement at least the startCompetition method, much like the
SimpleRobot class does.

For example, the simpleRrobot class definition looks approximately like this:

class SimpleRobot: public RobotBase
{
public:
SimpleRobot () ;
virtual void Autonomous () ;
virtual void OperatorControl () ;
virtual void RobotMain () ;
virtual void StartCompetition () ;

private:
bool m robotMainOverridden;

}i

It overrides the startCompetition method that controls the running of the other methods and it adds the
Autonomous,OperatorControl,EnuiRobotMainInethodsfrheStartCompetitionInethodlooks
approximately like this:

void SimpleRobot::StartCompetition ()
{

while (IsDisabled()) Wait (0.01); // wait for match to start
if (IsAutonomous ()) // 1f starts in autonomous
{
Autonomous () ; // run user-supplied Autonomous code
}
while (IsAutonomous()) Wait(0.01); // wait until end of autonomous period
while (IsDisabled()) Wait (0.01); // wait out the disabled period
OperatorControl () ; // start user-supplied OperatorControl code

}

[t uses the IsDisabled and IsAutonomous methods of RobotBase to determine the field state, then calls
the correct methods as the match progresses.

Similarly the 1terativeRobot class calls a different set of methods as the match progresses.

Watchdog timer class

The Watchdog timer will stop the robot’s motors and pneumatics if the program goes into an infinite loop
or crashes. A watchdog object is created inside the rRobotBase class (the base class for all robot
programs). Your robot program is responsible for “feeding” the watchdog periodically by calling the

Feed () method on the Watchdog. If you don’t feed the Watchdog often enough, it will stop all of the
robot’s motors and pneumatics.

The default expiration time for the Watchdog is 500ms (0.5 second). Programs can override the default
expiration time by calling the setExpiration (expiration-time-in-seconds) method on the Watchdog.

Using the Watchdog timer is recommended for safety, but it can be disabled. For example, during the
autonomous period of a match the robot needs to drive for drive for 2 seconds then make a turn. The
easiest way to do this is to start the robot driving, and then call wait to wait for 2 seconds. During the 2-
second wait, it can’t feed the Watchdog. In this case you could disable the Watchdog at the start of the
Autonomous () method and re-enable it at the end. A better approach is to set a longer watchdog timeout
period so you still get most of the watchdog protection.



void Autonomous ()

{

GetWatchdog () .SetEnabled (false) ; // disable the watchdog timer
Drivetrain.Drive (0.75, 0.0); // drive straight at 75% power
Wait (2.0) ; // wait for 2 seconds

GetWatchdog () .SetEnabled (true) ; // reenable the watchdog timer

}

You can call Getwatchdog () from any of the methods in a RobotBase subclass.

Waiting for 2 seconds has another problem: This robot program’s teleoperated code will start up to 2
seconds late if autonomous mode ends near the start of those 2 wait seconds since the teleoperated code
won’t start until the Autonomous method returns.



Contributing to the WPI Robotics Library

We are accepting requests from teams or groups of team members who would like to create Community
projects to share with other FRC teams. Those projects can be hosted on our SourceForge server located
at http://firstforge.wpi.edu. These community projects will have an administrator member and
contributors to the project. All the project code will be readable by the entire FIRST community but only
designated project members can make changes.



